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About this manual
Congratulations on your purchase of the NCSS statistical package! The NCSS statistical
package offers:
• Easy data entry.
• Statistical routines that provide high quality and accuracy yet are quick and easy to

learn and use.
• Straightforward procedures for creating paper printouts and file copies of both the

results of the statistical analyses and graphical representations of those results.

Our goal is that with the help of this NCSS Quick Start booklet, you will be up and
running on the system in less than one hour. Specifically, you will quickly and
successfully complete the following tasks:
• Enter a small set of data into NCSS (that is, create a database), label the variables, and

print a hard copy of your data.
• Compute descriptive statistics on the data in the database which you created.  Also,

run a t-test and a regression analysis on your data.
• Print copies of the descriptive statistics reports and the other reports which you

generate.  Also, print graphical representations of those analyses.  Also, export your
text and graphic material to a word processing program such as Microsoft Word or
WordPerfect.

I believe you will find that this NCSS Quick Start booklet provides a quick, easy,
efficient, and effective way for first-time NCSS users to get up and running. NCSS users
needing details on how to execute particular tasks should find the self-help chapters in the
second half of this booklet very useful.

I look forward to any suggestions you have to improve the usefulness of this manual
and/or the NCSS system. Meanwhile, good computing!

Jerry Hintze, Author
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CHAPTER 1

Installation
Before you install

Check system requirements
NCSS can run on any system that can run 32-bit Windows applications. This includes Windows 98,
Windows ME, Windows NT 4.0, or  Windows 2000. The recommended minimum system is a
Pentium PC with 32 MB of memory. NCSS has been tested on systems with only 16 MB of memory.

NCSS takes up about 25 MB of disk space. If space is tight, you can reduce this by deleting its help
(*.hlp) files. Once installed, NCSS requires about 5 MB of temporary disk space while it is running.

Find a home for NCSS
Before you start installing, decide on a directory where you want to install NCSS . By default, the
setup program will install NCSS in the NCSS97 (or NCSS2000) directory of your C drive. You may
change this during the installation, but not after, so make sure you have the required disk space on
the drive you will install NCSS on.

What install does
When you insert the CD into your computer, it will automatically load and run the installation
program SETUP.EXE contained in the NCSS97 directory on the CD. If you have previous installed a
copy of NCSS, the installation program will replace all outdated files with their current versions.

This version of NCSS contains PASS within it. If you have not purchased PASS, you will be able to
try it out for 30 days from the date you first use it. After the trial period, you will need to purchase a
separate license to continue using PASS.
The installation procedure (Setup) creates the necessary directories and copies the NCSS and PASS
programs from the CD to those directories. The files on the CD are compressed, so Setup
decompresses these files as it copies them to your hard disk.

The directories created by Setup are (either NCSS97 or NCSS2000 may be substituted below):

\NCSS2000 (or your substitute directory) contains most of the program files.

\NCSS2000\DATA contains all of the database files used by the tutorials. We recommend creating a
sub-directory of this directory to contain your data.

\NCSS2000\JUNK contains temporary files used by the program while it is running. Under normal
operation, NCSS will automatically delete temporary files. After finishing NCSS , you can delete any
files left in this directory.

\NCSS2000\REPORT is the default directory in which to save your output.
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\NCSS2000\SETTINGS contains the files used to store your program options. These files are used by
the NCSS Template system which is described later.

\NCSS2000\STS contains all labels, text, and online messages. The text in these files may be
customized. For example, you may want to modify report headings or help messages. You may even
want to translate this text into languages other than English.

Setup places a file called NCSS97.INI in your Windows directory. This file contains all default
settings, paths, and constants that are used by the system. This file is documented in README.WRI.

If you have a previous version of NCSS
If you are upgrading from a previous version of NCSS, instruct the Setup program to install the new
version in the same directory as your previous version (usually \NCSS97). All appropriate files will
be replaced. This includes your template files in the SETTINGS directory. If you want to keep these,
you must copy them to a separate directory before you begin the installation and copy them back
after completing the installation.

Installing NCSS
This section gives instructions for installing NCSS on your computer system. You must use the
NCSS Setup program to install NCSS. The files on the CD are compressed, so you cannot simply copy
the diskettes to your hard drive.

After you run Setup, you should read the NCSS README.WRI file for late-breaking information
before starting NCSS.

Follow these basic steps to install NCSS on your computer system.

Step Notes

1. Make sure that you are using a 32-bit version of Windows such as Windows ME or Windows
2000.

2. Insert the CD in the CD drive. On the Start menu, select the Run command. Enter D:Setup
(You may have to substitute the appropriate letter for your CD drive if it is not D.).

3. Once Setup starts, simply follow the instructions on the screen. NCSS will be installed in the
drive and directory you designate.

If something goes wrong during installation
The installation procedure is automatic. You simply put the appropriate diskettes in the floppy drive
when directed. If something goes wrong during installation, delete the \NCSS97 directory and start
the installation process at the beginning. If trouble persists, contact our technical support staff as
indicated below.

Obtaining the Documentation
A complete set of documentation is contained on this CD in the directory /NCSS97/DOCS. This
directory contains Adobe Acrobat PDF files that can be easily browsed and printed. A
comprehensive table of contents is contained in the text file _READ_ME.TXT. You can access this
file by double-clicking on it from Windows Explorer or by loading it into your word processor.
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The DOCS directory also contains a free copy of Adobe Acrobat Reader 4.0. You can install the
reader by double-clicking on the file Acrd4enu.exe. Note that this is a copyrighted program from
Adobe. You should read their licensing agreement that says that you can not sell the Reader program.

Note that to access the CD, you insert it and wait for the installation window to appear. Instead of
installing the software, select Cancel Installation. Now you can use Windows Explorer to browse the
CD.

Starting NCSS
NCSS may be started using your keyboard or your mouse using the same techniques that you use to
start any other Windows application.

Starting NCSS using your mouse
You can start NCSS by selecting NCSS from your Start menu using standard mouse operations.

Starting NCSS using your keyboard
You can start NCSS by selecting NCSS from your Start menu using standard keyboard operations.

Obtaining Help
Online Help
To help you learn and use NCSS efficiently, most of the material in this manual is included in the
online Help. The online Help is started from the Help Menu.



Installation4

Since the Help information is stored electronically, it can be changed more quickly than the printed
manual. Hence, you should always look to the online Help for information on procedures that is not
contained in this manual. Also, whenever you notice differences between the online instructions and
the printed instructions, you should assume that the online instructions are more current and follow
them.

Using Help
There are a few key features of our help system that, if you understand, will let you use the online
help more efficiently.

First, the Contents button brings up the table of contents of the help system. Use the Contents button
to quickly navigate through the Help system.

Second, each chapter was designed to be easily navigated. You can then proceed through a chapter
section by section using the period and comma keys on your keyboard.

Finally, you can use the Index and Find buttons to bring up an index of subjects.

Technical Support
To help us answer your questions more accurately, we may need to know about your computer system.
Please have pertinent information about your computer and operating system available. Also, many help
calls will require us to have an understanding of your data. Be prepared to provide background on your
data.

You can contact our technical support by calling (801) 546-0445 between 8 a.m. and 5 p.m. (MST).
You can contact us by email at Support@NCSS.COM or by fax at (801) 546-3907. Our goal is to
respond to Email within 24 hours and to faxes within 3 days, so please use Email whenever possible.
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CHAPTER 2

Creating a
database
About this chapter (Time: 21 minutes)
This chapter will show you how to enter, label, save, and print a database. You will find complete
coverage of these subjects in the first four chapters of the NCSS Users Guide.

Starting NCSS
Select Programs - NCSS from the Start menu to start NCSS. After starting, the NCSS  spreadsheet
program appears with an empty datasheet. We will begin by entering data into this datasheet.
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Brain Weight Data
The following data give the body weight in kilograms and the brain weight in grams of various
mammals. This chapter will show how to enter these data into an NCSS  database and perform basic
database operations such as saving and printing.

Mammal Body Brain
Name Weight Weight
African Elephant 6654 5712
Asian Elephant 2547 4603
Giraffe 529 680
Horse 521 655
Cow 465 423
Gorilla 207 406
Pig 192 180
Jaguar 100 157
Man 62 1320
Chimpanzee 52 440
Gray Wolf 36 120
Kangaroo 35 56
Baboon 11 179
Red Fox 4 50
Cat 3 26

Entering a column of data
Take the following steps to enter the brain weight data into NCSS :

1 Position the cursor in the
upper-left cell.

This is done by clicking in the
cell just below the C1.

2 Type African Elephant.

Notice that as you type, the
characters appear in two
places: in the cell where you
are typing and in the cell-edit
box at the top of the sheet.
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3 Press Enter.

The text is entered and
the cell cursor (the dark
border around the cell)
moves down to the next
cell.

4 Type Asian Elephant.
Press Enter.
Type Giraffe.
And so on until you
finish entering the
names.

5 Using the vertical scroll
bar or the Page Up key,
reposition the screen so
that you can begin
entering data in the
second column.
Click in the first row of
column two. This will
highlight this cell.

6 Type in the second and
third columns of
numbers. The
completed table should
appear as shown.

To cancel an entry, you can
press the Esc key. If you
have already pressed Enter,
you can choose Undo from
the Edit menu.
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Labeling a variable
In NCSS, a column of data is called a variable. Each variable has a number and a name. The number is
its column number. The name is the label at the top of the column. The name of the variable will be
displayed in all statistical reports and graphs that you generate, so it is important to name variables so
that they will be remembered.

In a new database, the variables receive the default names C1, C2, C3, etc. Hence, you have just
entered data into variables C1, C2, and C3. We will now show you how to change the names of these
variables.

1 Click on the Variable Info tab.

2 Click in the C1 cell.

This will position the cell cursor
in that cell. (The cell cursor
may already be there.)

3 Type Name.
Press Enter.
Type Body_Weight.
(Use the underscore, not the
minus sign in these names.)
Press Enter.
Type Brain_Weight.
Press Enter.

4 Click on the Sheet1 tab.

This will return you to a view
of the data. The screen should
appear like this.
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The final step is to widen
the columns so that the
complete names and
labels are shown.

5 Drag the mouse from the
Name heading to the
Brain_Weight heading.
This is done by pressing
the left mouse on the
heading Name and, without letting up, moving the mouse pointer to the heading Brain_Weight and
finally letting up on the mouse. All three columns (headings and data) will be darkened.

6 Now, position the mouse
between the two columns.
The mouse pointer will
change to a two
directional arrow.

7 Drag the mouse to the
right until you are almost
to the next border and let
go of the mouse button.

The columns will be
widened, showing the
complete variable names
(column headings) and
animal names.
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8 Click on a cell in the body of
the table to cancel the selection
(the reverse video).

Variable names are used throughout the program to identify which columns of data to analyze. A
variable name must begin with a letter (not a number); should contain only letters, numbers, and the
underscore; and should not contain blanks. For correct formatting on reports, variable names should be
less than fourteen characters, although there is no maximum length.

Saving your database
As you enter data, it is stored in your computer’s temporary memory but not on your hard disk. If the
computer loses power, you lose your data. We will now show you how to save the data  to your hard
disk.

1 Select Save As from the
File menu of the Data
window.
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2 Double-click the Data
directory to open it.

3 Enter mydata.s0 in the File
Name box.

4 Click Save.

An NCSS database name must end with the file extension s0 (that’s “s zero”). Hence, a valid file name
would have numbers, spaces, and letters followed by the extension “s0”. For example, you might use
abc.s0.

The database is stored as two files on your hard disk. If you use Windows Explorer to view the Data
directory, you will find that you have created two files: mydata.s0 and mydata.s1.

Printing your database
You will often want to create a printout of the data you have entered. We will now show you how this
is accomplished.

1 Select Data Report from
the Data menu.

The Data Report
procedure appears. This
window allows you to
control the format of your
report.

2 Click on the button to the
right of the Data Variables
line.
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3 Select the first three variable
names: Name,
Body_Weight, and
Brain_Weight.

Press Ok.

These variable names will
appear in the Data Variables
box.

4 Enter 2.0 in the First box of
the Tabs section at the
bottom of the window.

5 Press the Run button on the
right of the toolbar at the top
of the window.
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The final result will appear as
shown.

6 Finally, select Print from the File
menu of the Output window. This
will display the Print dialog box
from which you can print the
report.

Congratulations! You have successfully entered and printed a set of statistical data. Analyzing these data
using the various statistical procedures will not be much more difficult.
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Clearing the database
As you move from analysis to analysis, you will often have to clear the datascreen so that new data may
be entered. This is done as follows. (Of course, you should save your data before clearing it!)

2 Click Ok.

This will clear the screen and
present you with an empty file
just like when you start the
program.

NCSS maintains two data formats. The spreadsheet (S0-type) format is for routine databases of under
1000 rows. The database (S0Z-type) format is for databases with more than 1000 rows.

1 Select New from the File
menu of the Data window.
(Use the Windows menu
to transfer from the
Output window to the Data
window.)

(If you have not
previously saved your
data, choosing New will
cause the program to ask
you if you want to save
the current datasheet
before it is cleared.)
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The three NCSS windows
As you have just seen, NCSS is controlled by three windows: Data, Procedure, and Output. Each
window has its own menu bar. Be sure you are in the correct window when you use the menu. For
example, the Save As command in the Data window saves your data, the Save Template command in
the Procedure window saves the procedures’s current settings, and the Save As command in the Output
window saves the current report. It is easy to forget which window you are in!

The NCSS Data window contains
the data that is currently being
analyzed. This window lets you
view, modify, and save your data.
It has the look and feel of a
spreadsheet.

Chapter 7 provides a closer look at
the Data window.

This is the main NCSS window.
Closing this window will exit the
program.

The NCSS Procedure windows let
you set the options for a particular
analysis. Whether you are running
a multiple regression, an ANOVA,
or a scatter plot, you will set the
options of this procedure in the
Procedure window.

Chapter 8 provides a closer look at
the Procedure window.

Closing this window will not exit
NCSS.
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The NCSS Output window displays
the output from the statistical and
graphics procedures. It serves as a
mini-word processor--allowing you to
view, edit, save, and print your
output.

Chapter 9 takes a closer look at the
Output window.

Closing this window will not exit
NCSS.

Moving from window to window
There are several ways of moving among the windows:

1 Remove the windows you are not currently using by minimizing them.

2 Arrange the windows on your screen so that all can be seen.

3 Use the task bar along the bottom of your screen.

4 Use the Windows menu.

5 Use the Navigator.

6 Use the toolbar (this is usually the quickest and easiest).
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CHAPTER 3

Data
Transformation
About this chapter (Time: 13 minutes)
This chapter continues the introduction to the NCSS  system by taking you through examples of using
transformations to create new variables. Specifically, you will be shown how to calculate percentages
and how to recode the values of a variable.

Starting NCSS and loading a database
If NCSS is not already running, start it up now by clicking on the NCSS  icon (refer to the beginning of
Chapter 2 for details). We will use the brain weight data that was entered in Chapter 2. These data are
stored in the MAMMALS database in the \NCSS\DATA subdirectory. To begin this tutorial, take the
following steps to load the MAMMALS database.

2 Double click the Data
subdirectory to select it.

1 Select Open from the File
menu of the Data window.

The File Open window will
appear.
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3 Double click mammals.s0 in the
list of available files.

4 Click the Open button.

This will load the MAMMALS
database into the Data window.
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Creating a percentage variable
5 Click on the Variable Info tab.

This will position you in the
Variable Info datasheet.

6 In the Transformation
column, click on the fourth
cell down--the one in the C4
row.

This will position the
spreadsheet cursor in this
cell. This is where the
transformation will be
entered.
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7 Type in the transformation expression:
Brain_Weight/Body_Weight/10.
(Be sure to type the underscores!)

Press Enter.

Notice that you edit the transformation
in the edit bar at the top of the
spreadsheet.

This step enters the new transformation
expression, but does not change the
data. The data are not generated until
the spreadsheet is manually
recalculated.

8 Click on C4 in the Name column and
type Percent and press Enter.

This renames the variable from the
default of C4 to a new value that better
describes the data in this column.

9 Double click on the cell in the fourth row
in the Format column.

This will display the Format window for
editing the format of the Percent
variable. Note that this format will not
influence the internal precision of the
data.
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10 Select the two-decimal format: 0.00
from the list.

Although it is not necessary to
reformat the numbers, it will make
viewing them much easier.

The completed screen will appear like
this.

11 Click the Apply Transformation
button on the toolbar.

This will cause all transformations to
be recalculated.

12 Click the Sheet1 tab.
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This is the final result.

Notice the new column of data
in the Percent variable’s
column.

You can see that the data is
actually stored in double
precision.

If you change or add data to either Body_Weight or Brain_Weight, the Percent variable’s values will
not be automatically recalculated. You must recalculate the database using the Apply Transformation
button or the Recalc All option of the Data menu.

Also remember that these changes are not automatically saved on your hard disk. If you want a
permanent copy of a database with new transformations, you must save this modified version of the
database using the Save option of the File menu in the Data window.
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Recoding a variable
It is often necessary to recode the values of a variable. As an example, we will recode the body weights
to form a new variable as follows. Animals with a body weight less than 100 kg will receive a value of
1. Animals with a body weight greater than or equal to 100 kg will receive a value of 2. The
transformation formula that will accomplish this is (Body_Weight>=100)+1. The expression inside the
parentheses results in a “1” if it is true or “0” if it is false. We will call the new variable SizeGroup.

1 Click the Variable Info tab.

2 Click the C5 name.

3 Type SizeGroup and press
Enter.

4 Click in the cell in the fifth row
and third column.

5 Type (Body_Weight>=100)+1
and press Enter.

6 Press the Apply
Transformations button to
generate the new values.

7 Click on the Sheet1 tab to
return to the data.
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The final result appears like this.

Saving the changes
It is important to save changes to your database. Take the following steps to do this.

1 Choose Save from the File menu of the
Data window.

2 Click Yes.

The MAMMALS database on your hard disk will be replaced with the revised edition.
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CHAPTER 4

Running
Descriptive
Statistics
About this chapter (Time: 8 minutes)
This chapter continues the introduction to the NCSS  system by taking you through an example of
using NCSS to obtain descriptive statistics.

Running descriptive statistics
In this section, you will generate descriptive statistics (mean, standard deviation, etc.) on the
Body_Weight variable in the MAMMALS data. To begin, start NCSS  and load the MAMMALS
database. Detailed instructions for doing this are at the beginning of Chapter 3. After the database is
loaded, follow these steps to run the procedure:

1 From the Descriptive Statistics
menu, select Descriptive Stats.
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The Descriptive Statistics window will
appear.

The next step is to select the variables
to be analyzed.

2 Double click in the Variables box or
click the small button to the right of this
box.

This will cause the Select Variables
button to appear at the top of the
window.

This will cause the Variables window
to appear.

4 Click on Body_Weight in the Variable
Selection List box.

The variable will appear in the
Variables Selected box.

5 Click Ok.

The procedure window reappears.
Note that the Variables option now has
a value of Body_Weight. This is the
name of the variable that was selected.

6 Press the Run button to run the
procedure and generate the following
output report.


